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time working with the Finder, the iMac Desktop where you organize al
files. In this chapter, you learn how to make the Finder work in a way
best for you, with hidden Dock features, special folders that do some o
work for you; combinations of windows and programs that you can :

anytime with a click;and more.

Using Different Window Modes .......cccoivveeeeecccrssssecasnns
Using Specialized Folders .......ccciiiiiiieeeeecennnnnecconaans
Bending the DocktoYourWill ..........cccciiiiiiiiiicennnncnns
Setting Up Custom Workspaces.....coceeeeeerossecccccccsssnnne
Automating RepetitiveTasks ......coveveieeerrnneecnccecennnns

FindingLostFiles.......cciiiiiiiiiiiiiieeroeecenncscnnennans




Using Different Window Modes

With two window modes and four different view options, your iMac has plenty of ways to show you
the contents of your hard drive and any other drive you have mounted. Which combination you
should use at any given time depends on what you're looking at and what you want to do with it.

Choosing the most useful window and
view mode

One of the most-discussed features in Mac OS X has been its single-window mode (see figure 1.1),
which was supposed to represent a huge leap forward in productivity. No longer would you spend
all your time moving windows around to get to other windows behind them. But it turns out that
sometimes you need more than one window open at a time to get things done. Fortunately for
iMac users, the traditional multi-window mode remained in the Finder as an option. So now you
have the best of both worlds.
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1.1 Single-window mode gets you the sidebar, the toolbar, and, it's true, less
screen clutter.



In the Finder’s traditional multi-window mode, double-clicking a folder spawns a new window so

that you can see both the original folder’s contents and the new one’s contents at the same time. If
you keep double-clicking down through the folder hierarchy, you can end up with dozens of win-
dows covering your desktop (see figure 1.2).In single-window mode, by contrast, when you dou-
ble-click on a folder shown in a window, it takes over that window to display its contents.You only
end up with another, separate window if you consciously create one with the New Window com-
mand (88+N); then you need to navigate to the folder you want to view in the new window.
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1.2 This situation is what single-window mode was intended to prevent.

When you're flipping through a series of folders to find something, you're best off in single-window
mode.The Finder’s Go menu helps you move quickly to different locations on your computer with-
out having to travel through all the intervening folders. On the other hand, when you're moving
files around on your iMac, multi-window mode is your friend, especially if you have lots of screen
real estate on which to scatter windows around.
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dow’s title bar. Choose any folder in the list to back out to that point in the hierarchy.
Even in single-window mode, a new window opens to display the contents of the

folder you chose, as long as you keep pressing the & key when you choose a folder

name.

Single-window and multi-window modes can display files in four ways:

@ Icon view. Use this option if the file stands out visually or if you only have a couple of
files in a folder and want a bigger target for double-clicking.

@ List view. If you need to find something by name or date or other attribute, use List view.
You can click and drag column headers to reorder the columns, click a column header to
sort by that attribute, and drag the right edge of a column header to change that col-
umn’s width.To control which columns are displayed, choose View => Show View
Options.

@ Column view. Particularly useful if you have similarly named files that are distinguished
by their locations, Column view lets you see the folder hierarchy in a logical way so you
can tell what’s inside what. Double-click the column sizer at the bottom of a column (it
looks like a vertical = sign) to resize the column’s width to fit its contents, and
Option+double-click any column sizer in a window to resize all the columns in the win-
dow to the same width, based on the widest item shown in the window.

© Cover Flow view. This view is an import from iTunes,and it's great if you're a visual

thinker.You can flip through files the same way you flip through CDs on a jukebox.

1

dates like “Today” and “Yesterday,” remember that OS X only updates those dates

o

Caution

when you close the window. So if the window you're looking at has been open since

yesterday, the dates are no longer correct.

Managing windows with Exposé

If you routinely have a lot of windows open — document windows, folders in the Finder, program
palettes, and toolbars — it gets pretty hard to find things sometimes.That’s what Exposé is for.You
can use keyboard shortcuts to shove extraneous windows out of the way so you can find what
you're looking for. Here are the basic Exposé shortcuts and how they work:



@ F9.Tiles all the open Finder and application windows so that you can see them all simul-
taneously (see figure 1.3). Mouse over each window to see its name, or press Option to
see all the names at once. Click to choose the window you want to activate, or press F9
when the mouse cursor is over the window you want.To drag a file to another applica-
tion (for example, something you want to attach to an e-mail), start dragging the file and
then press F9.When you find the window you want, press F9 to make that the active win-

dow, and then release the mouse button to drop your file into the window.
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See all the open Finder and program windows by pressing F9.

@ F10. Highlights all the open windows in the current application (see figure 1.4).Click to
choose the window you want to activate, or press F10 again to return to the window
from which you came.If you want to copy content from one window to another in the
same program, select the content and start dragging it,and then press F10.Find the win-
dow you're looking for, press F10 again to activate it,and drag and drop the content to

the correct location.
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See all the windows belonging to the frontmost program by pressing F10.

@ F11. Shows the desktop, shifting open windows in the Finder and all applications off to
the sides of your screen. If you want to drag an item to the desktop, start dragging, and
then press F11 without releasing the mouse button to reveal the desktop.Press F11 to
restore the windows to their previous locations.

Note

The buttons shown in the Finder single-window mode’s toolbar are the ones Apple thinks you'll
use most often. Sometimes, however, Apple is wrong. Fortunately, you can modify the toolbar to
include the buttons you really want and leave off the ones you don’t.To make quick changes, press
8 and drag a button off the toolbar to delete it or to a new location to move it. For a major over-

haul, follow these steps:



1. Inthe Finder, open a Finder window and choose View > Customize Toolbar (see
figure 1.5).
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1.5 Make the toolbar work the way you want it to, not the way Apple thinks it should.

2. Drag any buttons you don’t want off the toolbar. They disappear in a puff of smoke.

3. From the selection of buttons, drag any buttons you want to add to the toolbar. You
can add buttons wherever you want, and you can add as many as you want. If you add a
duplicate of a button that'’s already on the toolbar, the original button disappears so that
there is only one copy.

4. Drag and drop to rearrange the buttons’ order on the toolbar. Use the Space, Flexible
Space, and Separator options to control the exact arrangement of buttons.

5. If you decide to revert to the original toolbar, drag the default set of buttons onto the
toolbar.

6. Click Done.

remembering which button does what, change the Show menu setting at the bot-

tom of the Customization dialog to Icon & Text. Or, to see each Show option in action,
press 88 and click the oval button in the upper right-hand corner of the window
repeatedly to cycle through the six possible settings.




Customizing the sidebar

Finder windows in single-window mode fea-
ture an area at the left called the sidebar (see
figure 1.6). Here you find locations you're
likely to visit frequently, neatly categorized
into Devices, Shared, Places, and Search For
sections. If you don't visit some of these loca-
tions, feel free to click and drag them right out
of the sidebar, or at least to the bottom of the
list; you can arrange them in any order you
want except for the items in the Shared sec-
tion. You don't need to press a special key to
do this; the sidebar is always open for editing.

Adding a file, folder, or program to the sidebar
is just as easy; track it down, make sure you're
in single-window mode (click the clear oval
button at the top-right corner of the window
to switch from multi-window mode), and drop
the new item into the Places section. | use this
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1.6 The sidebar provides convenient access to
locations you often access from the Finder.

feature to keep the folders for my current freelance jobs at my fingertips, and some of them have

rather long names, so | widen the sidebar by clicking and dragging its right edge.

Here’s what you'll find in each section of the sidebar:

@ Devices. In this section, you see your computer and each hard drive, thumb drive, or

camera attached to your computer, including your iDisk.

®

®

Shared. Here you find shared computers on your local network.

Places. This section starts out containing your home folder and some of the folders

inside your home folder, but you can add whatever you want here:files, folders, pro-

grams, Web bookmarks, whatever tickles your fancy.

®

Search For. A few smart folders (saved searches, explained later in this chapter) are

already set up for you, and this is where you can access them.Three show documents

that have been modified today, yesterday, or in the past week, and three display different

kinds of documents.
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You can easily specify which categories of items appear in the sidebar. In the Finder, choose
Finder => Preferences and click the Sidebar tab. If you don’t want your iPod showing up in the side-
bar every time you plug it in, for example, uncheck the box next to CDs, DVDs, and iPods.

Viewing full-screen file previews

The latest release of Mac OS X, called Leopard, introduced a way to see the contents of files in the
Finder without having to open them. It’s called Quick Look, and it’s invoked by clicking a file and
pressing the spacebar. A window pops up, displaying the contents of the file along with controls
for viewing the file full-screen, playing it (if applicable), scrolling through its pages if it has them,
and closing the Quick Look window (see figure 1.7).

1.7 To see the contents of this PDF file, you don't have to open it; just take a
Quick Look by pressing the spacebar.

Quick Look works with a surprising range of document types. Of course, it’s great for peeking into
image files and PDF documents, but it can also display an Excel spreadsheet, a Word document, or
a movie — and the movie plays while you're looking at it. If you activate Quick Look with multiple

11



documents selected, you can use the arrow keys to view each document in turn, and you can see
the thumbnails of all of the files in a grid by clicking the Index Sheet button next to the Full Screen
button at the bottom of the Quick Look window.

To close the Quick Look window, press the spacebar again.You don't have to close it when you finish
looking at one document, however; you can keep the window open and it displays whatever docu-
ment you click on as you move around the Finder. If you need to zoom in on the document you're
viewing, no problem; Option+click anywhere in the preview image to zoom in once and repeatedly
to continue zooming in. Shift+Option-clicking zooms you right back out again in the same incre-
ments.When you're zoomed in, you can click and drag the picture around within the window.

Using Specialized Folders

For the most part, the folders that you create in the Finder are simply containers for files and other
folders. But you can make your folders do more for you. Smart folders perform the kind of function
that computers were supposed to be doing for us all along. Instead of you keeping track of which
files belong in which folder, your iMac can do the work for you. All you do is tell the system how you
want it to choose files to put in the folder, and then whenever you open that folder the right files
are automatically there. Burn folders are a little different. A burn folder serves as a catch-all for the
files you want to burn to disc. Drop files in there and choose File = Burn to Disc whenever you're
ready, and then delete the whole folder or just its contents without ever touching the original files.
Burn folders use aliases to copy the right files onto your disc while leaving the originals in place.
And any folder, including a smart folder or a burn folder, can have actions attached to it, so that it
will automatically do its assigned job whenever the trigger event you've specified occurs.

Creating smart folders

When you need a folder to contain a constantly changing set of documents, follow these steps to
make a smart folder do it for you:

1. Choose File => New Smart Folder, or press 88+Option+N.
2. Choose the criteria for the smart folder (see figure 1.8):

Type keywords related to the subject or project in question. For example, to locate
files related to this book, | might make a smart folder based on the keywords “iMac” and
“genius.”

Choose This Mac, Servers, or your home folder to specify where you want to look for
files. This Mac includes files anywhere on your computer; Servers includes files located
on other computers on your network.

12



Choose Contents or File Name. Contents is the default choice, and it allows the smart

folder to include any file that mentions the keywords anywhere within the file; if you
choose File Name, the keywords must be part of a document’s name for that file to be
included in the folder.

3. Click the plus button to add additional criteria, such as a date range or a label color.

you can specify a particular criterion, select the check box next to its name to add it

(W ITEM to the menu.Then you won't have to go looking for it the next time you need it.

=R e
Search for: | greyhound
Search: “kb* | File Name (_Save ) (+)

MName
] Irregularities ...ationals.doc Microsoft Word document October 15, 2007, 10:33 PM
Chat transcript Oct 12, 2007, 11:51 AM
Adobe PDF document
Adobe PDF document

% kb + [ Documents » B8 GSG + (B 2007 Nats » % rule_book_11.0.pdf

1.8 This smart folder collects files containing the word “greyhound” that are
located anywhere on my iMac.

4. Click Save, and then choose a location and enter a name for the new folder. The Finder
always defaults to the Saved Searches folder, which is where smart folders need to be in
order to appear in the sidebar under Search For, but you can put your smart folders wher-
ever you want them.

ment, select the file, choose File = Get Info, and type the keywords in the Spotlight
(-, ]{TII Comments field at the very top of the Info window.
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Making burn folders

Using a burn folder is a good way to collect files you want to burn to disc while you're working,
before you're ready to actually insert the disc and burn it. You might use a burn feature for a peri-
odic backup by dragging documents or folders into it over the course of a day, and then burning a
disc from it just before you quit work for the day.

To create a burn folder, choose File &> New Burn Folder. By default, the folder is named “Burn
Folder,” but you can change the name to whatever you want. Drag files and folders to the burn
folder, which is created on the desktop (although you can move it wherever you want). When
you're done, open the folder, double-check the contents, and click Burn. A confirmation dialog
appears;insert a blank CD or DVD and click Burn again.Your iMac burns the disc, verifies it by com-
paring the disc to the original data,and mounts the disc on your desktop.

ders that you see in a burn folder’s window are aliases and

be deleted with impunity; if you double-click one of these folders, you're actually

(111l opening the real folder. So be careful!

Attaching automated actions to folders

Folder actions are another way to make your iMac do some of the grunt work so you can spend
your own valuable time on more creative endeavors. Essentially, they're scripts attached to folders;
when the right trigger takes place, such as files being added to a folder, the script activates.You can
use folder actions to do things like convert all the images you drop into a particular folder to JPEG
format, move documents to more appropriate locations based on their file types, or notify you
whenever new files are dropped into your Public folder.

The Finder comes with a few scripts that are [@O6  FolderActionsSewp |

ready to attach to your folders. To access # Enable Folder Actions

them, first Ctrl+click a folder icon and choose s Foldars 2t s el o Ot i [
g 4729 Portable Genius ﬂ add - new item alerr.scpt

More > Enable  Folder  Actions. Then M Burn Folder

Ctrl+click the folder and choose More =
Configure Folder Actions.First,choose a folder
to automate by clicking the plus button on
the left side of the Folder Actions Setup dialog
and then navigating to the folder you want to
use, then attach an action to it (see figure 1.9). [+]-] (" Editseript )

1.9 This folder action lets me know any time a
new file is added to my Faxes folder.

14
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You can use folder actions to notify you whenever you receive a fax with your iMac’s fax modem.
First, open the Folder Actions Setup dialog (Ctrl+click and choose More => Configure Folder
Options). Choose the folder where the faxes you receive are saved (by default, this is the Faxes
folder within the Shared folder) and click Open. When you see the Choose A Script dialog, click
“add - new item alert.scpt” and click Attach, and then close Folder Actions Setup. An alert dialog
appears every time a fax is received and saved in that folder.

Actions Setup dialog and click the plus button under the Script pane to add an addi-

tional action.

Bending the Dock to Your Will

Every iMac user has a different idea of what the Dock should do and how it should do it.| prefer to
use my Dock as a process dock, with icons only for currently running programs. You, on the other
hand, may prefer to stick anything and everything into the Dock: programs, folders, documents,
URLs, the works. The nice thing about the Dock is that it works both ways, and you can use it as lit-
tle or as much as you prefer. The following sections show you a few ways to work with the Dock
that you may not have known about before.

Accessing hidden Dock features

The Dock can do a lot of things that aren't immediately apparent from looking at it. Some of the
Dock’s coolest features, in fact, are not normally accessible, but you can invoke them using a free
utility called TinkerTool (Marcel Bresink Software-Systeme, http://bresink.com/osx/TinkerTool.html).
Here’s a list of TinkerTool’s Dock-related features:

@ Disable the three-dimensional glass effect of the Leopard Dock
@ Add a shadow to the Dock

@ Add hidden and system files in the Dock’s contextual menus

@ Lock the Dock so that its size can’t be changed

@ Lock the Dock so that its contents can't be changed

@ Put the Dock at the top of the screen

@ Put the Dock at the beginning or end of any screen border

@ Change the animation used when you minimize a window into the Dock

15



TinkerTool can also do dozens of things that have nothing to do with the Dock. Check out the Web
site for more information.

Meanwhile, if you want to master the Dock, there’s a lot to learn. For example, did you know that if
no Finder windows are open, you can open a new Finder window by clicking the Finder icon in the
Dock, which always appears at the Dock’s left-hand end? Read on for more Dock secrets.

Driving the Dock with keyboard shortcuts

Forget Coke versus Pepsi and Mac versus Windows — the real battle of the millennium is mouse
versus keyboard. Those who've forsaken their mice and learned all the keyboard shortcuts their
brains can hold will swear up and down that keyboarding is always faster than mousing. Others
cite Apple research conducted in the 1980s that concluded that keyboard users only think they're
working faster by forsaking the mouse. So I'm staying out of this argument — but | will say that I'm
a big keyboard-shortcut user myself. It just feels faster...

Apple doesn't talk much about this fact in its marketing materials, but it just so happens that most of
the Mac OS X interface can be navigated entirely via the keyboard, including the Dock. Give this a try:
Press Ctrl+F3,and then use the arrow keys to move back and forth across the Dock.When you get to
the program you want to use, press Enter to switch to it. If you use the Dock’s Hiding feature, press
Ctrl+F3 again to hide the Dock.Here are a few other useful keyboard shortcuts to use with the Dock:

®

88+Option+drag a file onto a Dock icon to force the file to open in that program.

»

) To hide all applications except the one you're clicking, 38+Option+click the chosen appli-
cation’s icon in the Dock.

@ When you're using a program’s Dock menu, press Option to change the Quit command
to Force Quit.

®

To reveal a Dock item’s location in the Finder, 88+click on its Dock icon.

»

' If you 8+drag an icon from the Dock, you'll move the icon’s original file to the new
location.

@ Shift+drag the Dock divider to place the Dock on the left, bottom, or right side of your
screen.

)]

) To restrict the Dock to its best-looking sizes as you resize it, press Option as you drag the
Dock separator.

»

) To temporarily toggle Dock magnification on or off, press Control+Shift.
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Sending text to other programs via the Dock

Copy and paste is convenient, but sometimes drag and drop is even more so.The Dock can provide
a pathway for you to move text from one program to another with minimal hassle. All you have to
do is select the text, drag it to a Dock icon, and release the mouse button to drop the text into that
program.Table 1.1 shows what happens in several programs when you try this neat little trick.

Table 1.1 How Programs Handle Dragged Text

Safari URL Opens the Web page

Text Performs a Google search using the text as the search terms
TextEdit Text Creates a new document containing the selected text
Mail Text Creates a new mail message containing the selected text
Stickies Text Creates a new sticky note containing the selected text

you're having trouble dragging text out of a Safari window, slow
literally. Click and drag to select the text, then click on the selection and hold the

mouse button down for a second before you start dragging.

Making the Dock better with third-party
software

These indispensable Dock add-ons can bring your Dock to a whole new level, whether you want to
add features or just change the way the Dock looks (see figure 1.10). And half of them are free —
how’s that for a deal?

1.10 Grab some Dock-flavored eye candy for yourself with DockChanger.

Gaining single-click access to system functions

How would you like to take a screen shot, empty the Trash, or restart your iMac with a single click?
Dockables (Free, COCOAapp, getdockables.com) makes all those possible, along with a slew of
other common tasks such as muting the sound and opening your screen saver. It's a set of tiny
applications that you can keep in a folder in your Applications folder and then add to the Dock one
at a time or en masse. The apps even come with three different sets of icons, so you can use the
ones that you think are best looking.
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Adding application status info to Dock icons

When you glance at iChat’s Dock icon, it tells you how many unread messages you have. Wouldn't
it be nice if other programs put useful information in their Dock icons, too? Docktopus ($20, Startly
Technologies, docktopus.com) makes it so by enabling you to add what the developer calls badges
to Dock icons.You're limited to nine types of badges, some of which are more useful than others.In
my opinion, though, the Mail Peek badge alone is worth the price of the package; it tells you how
many unread messages you have in specified e-mail accounts. Mail does this all by itself — but if
you use another e-mail program, you need Docktopus to gain this feature.

Putting Tiger-style hierarchical menus in your Leopard dock
When Mac OS X 10.5 (Leopard) came out, Apple thought users would love its new Stacks feature.
Stacks, of course, are an attractive way to view the contents of folders from the Dock, but they can't
do one thing that you could do with folders in the Dock before: display folder hierarchies.
HierarchicalDock (Free, Eternal Storms Software, eternalstorms.at/utilities/hierdock/) brings that
capability back to Leopard so that you can click a folder in the Dock, move up the list of its contents
to another folder’s name, and move to the side to choose a file from among the contents of the
second folder.It's a small feature, but a nice one.

Customizing the Dock’s appearance with themes

Apple keeps futzing around with the Dock’s appearance; it used to be a simple, translucent pane,
and now it's a bright, shiny shelf. If that doesn’t suit you, though, you can futz around with the
Dock’s appearance all by yourself,and with much more interesting options.To get an idea of how
your Dock could look (Crumpled pirate map? Black leather? Chain link fence?), head over to
LeopardDocks.com and take a look at the site’s downloadable Dock themes. Then download
DockChanger ($10, Whimsplucky Software, whimsplucky.com), so that you, too, can put these gor-
geous themes into action on your iMac. Whimsplucky produces a new set of themes every month,
and the program’s devotees are creating more all the time, so you can have a different Dock every
single day if you're so inclined.

Inserting additional separators

It's hard to imagine that you would ever want to download an application that does precisely
nothing, but that’s exactly what you get when you download iPassion Dock Separators (Free,
ipassion.it/dock-separators-support/). In fact, you get quite a few applications that do nothing,
each with a different attractive icon that makes a great separator for your Dock. Use these tiny
graphics to organize your Dock by grouping its icons into categories that make sense to you.You
can even add labels under the separators to indicate what's what.
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a Dock folder’s contextual menu. That's still not quite as simple as the way folders

worked pre-Leopard, however, so HierarchicalDock remains one of my favorite
utilities.

Trying a Dock alternative: DragThing

Whether you like the Dock or loathe it, you can’t deny that it doesn’t do everything. And that’s okay.
For those who want a different Dock, there are all kinds of alternative application launchers out
there. My favorite is DragThing (529, TLA Systems, dragthing.com).You can use DragThing to set up
multiple docks, each with its own custom appearance, and use keyboard shortcuts to open Dock
items and control DragThing in other ways. It can use sounds to give you audible feedback so you
know when you've done something, and you can use it to store pictures and text clippings that
you can paste into documents with a single click. Use it instead of the Dock or alongside the Dock,
whichever you prefer.

Setting Up Custom Workspaces

Spaces, introduced with the Leopard release of Mac OS X, are Apple’s implementation of a concept
called virtual desktops that’s been around for decades. Using Spaces, you can clear your Desktop
instantly in the middle of a project and start a whole new project, with different applications and
open folders.Then you can switch back and forth between the two (or more) instantaneously.The
advantage is that you don't have to deal with the clutter caused by having all your open windows
and programs visible all the time.

You can turn on and configure Spaces by choosing Apple menu > System Preferences and click-
ing Exposé & Spaces, then the Spaces tab (see figure 1.11).

Select both check boxes at the top of the tab, which enables Spaces and adds a Spaces menu to
your menu bar. You may end up removing the Spaces menu later — just 88+drag it off the menu
bar to do that — but | find that it's the easiest way to navigate from one space to another when
you're just getting used to Spaces. Now, decide how many spaces you want to start with and adjust
the Row and Columns settings to create that many spaces in your preferred arrangement. When
you finish, close System Preferences.

Now you can start making the most of your spaces. If you open a Finder window or start up an
application in one, then switch to another, you won't see those windows in the new space. Switch
back to the original space, and the windows reappear.
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Spaces lets you organize your windows into groups to reduce desktop clutter.
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To activate Spaces: | F&
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| have three spaces defined, which enables me to switch between two
different work projects and one space for what | like to think of as necessary
distractions such as Web surfing.

After you set up multiple spaces, you need to be able to move from one to another before they do
you any good. Of course, you can use the Spaces menu in the menu bar (turn it on in the Spaces
section of System Preferences), but using keyboard shortcuts is much faster. Start by pressing Ctrl
as you press the arrow keys. This moves you around the grid of spaces shown in the Spaces prefer-
ences.You can also use Ctrl combined with the number keys to jump directly to a space that isn't
adjacent to your current space.

If you're hopelessly confused by now, press F8 to see a bird’s-eye view of your spaces (see figure
1.12).Click the one you want to use,and you're immediately moved to that space. Or, if you just want
to see what each of your spaces looks like, press and hold F8; the same overview appears, and
then disappears when you release F8.You can choose another key for this shortcut, as well as for
using the arrow keys to switch spaces, in the Keyboard and Mouse Shortcuts area of the Spaces
preferences.
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To change spaces via the Dock, click an application icon to move to the first space where that pro-
gram has an open window. Click again to move to the next space. As you move around from space
to space, you'll notice that some dialogs such as error messages appear in whatever space you're

currently using, even if their program’s running in a different space.

Genius

My spaces look funny because | use two monitors, so each space thumbnail shows the windows

placed on both screens.



Some people tend to take an ad hoc approach to spaces—in other words, are things getting
messy? Make a new space! Others like to use the same set of spaces from day to day, and for this
group it's useful to be able to stick a program to a space such that you're automatically switched to
that space whenever you switch to that program. Follow these steps to do just that:

Choose Apple menu => System Preferences. Click the Exposé and Spaces button, then the
Spaces tab.

In the Application Assignments section of the preferences pane, click the plus button

to add a program. In the Open dialog, choose the program you want to assign to a space,
and then click Add.

In the right-hand column, choose the space to which you want to assign the applica-
tion (see figure 1.13). From now on, whenever you open that application or it displays an
alert dialog, you're automatically switched to the selected space.

800 Exposé & Spaces

(<[> ) [ showau ] Q)

1 Exposé | Spaces ]

Spaces lets you organize your windows into groups to reduce desktop clutter.
E Enable Spaces

ashow Spaces in menu bar

Rows: @
Columns: @ @
| Space
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W Microsoft Word Space 1
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~

Keyboard and Mouse Shortcuts (for more shortcut choices, press Shift, Control, Option, or Command)
e %)
To switch between spaces: | * Arrow Keys g ]
To switch directly to a space: | ~ Number Keys -3]

To activate Spaces: | F&

@

By assigning PowerMail to every space, | can use it at any time without
switching spaces.



4. To force an application to appear in all your spaces, choose Every Space in the right-
hand column.

’D' If you're working in the Spaces preferences and you remove a Column or Row to

which you've assigned applications, you see a message pointing out that those
Note application assignments need to be changed.

Moving windows among spaces

To place a window in another space, drag it to the edge of your screen and wait a second. If there’s
a space in that direction, you'll switch to that space and the window will come with you. If you lose
track of which spaces are located in which direction, press F8 to see the overview.This might take
too long if you have a lot of spaces, so you can also move windows around in the Spaces overview
simply by clicking a window in one space and dragging it to another space in the overview. Drag
the blue background to move the whole space to a different position in the overview.

Another way to move windows among spaces is to press the destination space’s keyboard short-
cut (such as Ctrl+2 for space 2) as you click and hold the window’s title bar. And finally, if you decide
you want to move all the open windows to a particular space, go to the overview (press F8) and
press C to consolidate them.

Automating Repetitive Tasks

Automator enables you to string together prebuilt actions into workflows that you can save and
then run just like any other Mac program.You don’t have to learn a programming language; all the
programming is done via drag and drop.With Automator, you can spend a few minutes setting up a
workflow, and then take a coffee break while your iMac does the grunt work for you. To help you
envision what Automator can do for you, take a look at a sample workflow (see figure 1.14) that
automatically sends birthday e-mails to people whose birthdays are recorded in your Address Book.

Press Shift as you drag a window to a new space in the Spaces overview to bring

along all the other windows from that program.

Genius
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[ Variables (Q send @) v \. Find People with Birthdays a
v [‘ Library ﬁ Add Atntac...t Message =
5 Catendar & Group Maler Find people whose birthday is

| Contacts B Mew Mail Message Wesults, Opelons. | Decorpoion
B Files & Folders i Send Birth... Greetings b M
W Fonts B Send Out... Messages [~ i Send Birthday Greetings 9\
e Internet
& Mail Happy Birhday!
(2 Movies
'}9 Music
[% PoFs
& Photos
9 Presentations
o Text
¥ Utilities
[ Most Relevant
[E8 Most Used
(i3 Recently Added Results Options  Description

] Random Image For Each Recipient
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(v & Send Outgoing Messages (x}

Results Options  Description

#- @ i

1.14 These few steps can ensure that you never forget your friends’ birthdays.

" H Automator comes with a wide selection of actions, but you can download more from

sites all over the Web. Start with Apple’s own Automator site: apple.com/down-
Note loads/macosx/automator/.

Renaming files automatically

One of the most boring and repetitive tasks you're likely to run into as a computer user is renaming
a large number of files, and it’s a job every computer user has to do at some point.This is exactly
the kind of work Automator was designed to take care of for you, and it’s one of the easiest work-
flows to design. Follow these steps:

1. Find Automator in the Applications folder and open it.
2. Click Custom and then click Choose to create a new workflow.

3. Inthe first pane, under Library, click Files & Folders. This category contains all kinds of
actions you can perform on files in the Finder, from duplicating documents to connecting to

servers.
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4. In the second pane, choose Get Folder Contents and drag it to the third pane. This first

action in your workflow determines which objects the workflow will act on. If the folders
you'll be working on have folders within them that also contain files to rename, select
Repeat for each subfolder found check box.

5. Choose Rename Finder Items, also in the Files & Folders category, and drag it to the
third pane under the first action. Automator asks you if you want to copy the files before
it renames them so that you'll have a backup. Click Add if you want to do this, or click Don’t
Add if you want to skip it.

)
[' j| If an action has a downward-pointing triangle that overlaps a semicircular tab

ing out from the top of the next action, this indicates that these actions work

Note together.If they don’t connect visually in this way, they don’t work as a sequence.

6. Using the pop-up menus in the Rename Finder Items action, choose how you want
your files renamed. If you need to use more than one type of renaming (such as Add Text

and Change Case), add the Rename Finder Items action again (see figure 1.15).

=
Variables (Q Narme D) L Results  Options  Description J
w [l Library & Ask for Finder Items - Yo
. - ~
i) Calendar B Ask For Servers v & Rename Finder Items ) i
L Contacts B Connect to Servers
B Files & Folders | B Copy Finder Items Add Date or Time |
|
T Fonts B create Archive Date/Time: | Current 54 Format [ Year MomthDay 18 |
@ Internet B Duplicate Finder ltems |
, - - Where: name Separator: | Da
W mai K Eject Disk [(Beforename 5] Sepa [Dash ) |
Q@ Movies Ky Filter Finder Items - [space 2] [ Use Leading Zeros |
@ Music K Find Finder ltems I
[¥ PoFs K Get Folder Contents Example:  2008-2-4 ltem Name.xocx |
& Photos & Get Selected Finder ltems Coi @etos Dl |
ED presentations | By Get Specified Finder Items - ~L “ N
] Te-x.t- B Get Spe.ciﬁed Servers o % Rename Finder.ltems a‘ i
¥ Utilities B Label Finder ltems
(& Most Relevant B Mount Disk Image t
(&l Most Used B Move Finder Items r \
onl to:
[ Recently Added & Move Finder ltems to Trash L =R _J |
B New Aliases |
B New Disk Image |
B New Folder i
B Open Finder Items Example:  item name.sxx |
B Rename Finder ems 4 Results Options Description 2
B Reveal Finder ltems e ’ v
B- @ i | =

1.15 This workflow first adds the date to each filename and then makes sure all the filenames are
lowercase.
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7.

8.

Choose File => Save As. In the File Format pop-up menu, choose Application, then type a
name, choose a location, and click Save.

To run the action, drag a folder onto it.

E-mailing a Web page

RSS feeds and e-mail notifications enable you to have the latest content from your favorite Web

pages delivered straight to you, so you don't have to go out looking for it. Unfortunately, not all

Web sites offer these features. Fortunately, you can use Automator to have Safari open a Web page

at scheduled intervals, attach its text to a Mail message, and send it to you so that you can read it

wherever you happen to be.Follow these steps:

d W N

10.
11.
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Start Automator (located in the Applications folder).
Click Custom and then click Choose to create a new workflow.
In the first pane, under Library, click Internet. Most of the actions in this category use Safari.

From the Internet category, drag the Get Specified URLs action into the workflow
pane. Fill in the URL of the Web page you want to mail, and give it a name if you want to
add it to your bookmarks.

. From the Internet category, drag the Get Text from Webpage action into the workflow.

This step essentially copies all the text from the specified Web page.

From the Text category, drag the New Text File action into the workflow. Give the new
text file a name in the Save As field and choose a location for it from the Where pop-up
menu.

Switch to the Mail category and drag the New Mail Message action into the workflow.
Fill out the To, CC, BCC, and Subject fields, then add a message, if you want, and choose
which e-mail account Mail should use to send the message.

Drag the Send Outgoing Messages action, also in the Mail category, into the workflow.
It has no options to set (see figure 1.16).

Choose File > Save As Plug-In. Choose iCal Alarm from the Plug-in For pop-up menu, and
then give the workflow a name and click Save.

Start iCal, then click and drag in the iCal window to create a new event.

Edit the event so that its Alarm is set to Open File, and then choose the workflow you
just created.
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1.16 With the addition of the Send Outgoing Messages action, the workflow is complete.

Making your iMac into an alarm clock

One of the first actions | created using Automator was designed to mute my iMac’s volume at the

end of the workday so | wouldn't keep hearing e-mail notifications throughout the evening and be

tempted to go back into my home office. Similarly, you can use Automator to start playing music or

any other kind of audio content at a specified time: your own custom alarm clock. Here’s how to

create the workflow you'll need and then schedule it:

1. IniTunes, set up the playlist you want to automate. You can include Internet radio sta-

tions as well as songs.

2. Start Automator (located in the Applications folder).

3. Click Custom and then click Choose to create a new workflow.
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. In the first pane, under Library, click Utilities. These actions can start programs and mod-

ify system settings.

. Drag the Set Computer Volume action into the workspace. Adjust the sliders to set the

volume to your preferred level.
In the Library, click Music. Most of the actions in this category use iTunes.

Drag the Set iTunes Volume action into the workspace. Adjust the slider again to set
iTunes’ volume level.

Drag the Get Specified iTunes Items action, also from the iTunes category, into the
workspace. Click Add, choose the playlist you created in Step 1,and click Add again.

Drag the Start iTunes Playing action, once again from the iTunes category, into the
workspace. Figure 1.17 shows the completed workflow.

PO O r——————l U ———— O

Variables (Q Name [+ % set Computer Volume L
» [l Library
(@ Most Relevant Output volume: o ; | A ; *’)) O Mute
Most Used
(B8] Recently Added Alert volume: * b4 0 \ | ' "))
Input volume: S.:' s ' ' ' ' g!'.
Results Options  Description J
v [ SetiTunes Volume (]
o o )

( Current iTunes Volume )

Results Options Description

v [ Get Specified iTunes Items (%]
| Name | |
#| Alarm Clock
Results Options Description )
PA .
(v 7 start iTunes Playing 1)

L Results Options Description

8- @ = | =

1.17 The alarm clock workflow only needs four steps to work.
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each day. That's why it's important to add the two Set Volume actions to the work-

flow. Whether you mute the volume to take a phone call or crank it up when your

favorite song starts playing, you'll be happier if the alarm clock volume isn’t too soft

or too loud but just right.

10. Choose File > Save As Plug-In. Choose iCal Alarm from the Plug-in For pop-up menu, and

then give the workflow a name and click Save.

11. StartiCal, and then click and drag in the iCal window to create a new event.

12. Edit the event so that its Alarm is set to Open File, and then choose the workflow you

just created.

the Visualizer to be.

Genius

To add a light show to your musical alarm, you can add the Start iTunes Visuals step

at this point in the workflow. The only option you need to set is what size you want

Recording your actions for playback

Automator’s library of premade actions is
broad, but not particularly deep, meaning that it
covers a lot of different areas but with only a
few commands for each. If the actions you need
to build a workflow don't exist in the Library,
you can create them by having Automator
record a series of steps you perform.

Before you start recording, decide what your
iMac should be doing when this action is
played. For example, you might have earlier
steps in the workflow start up certain programs,
so those programs should be already running
when you start recording. Once you're set up,
start Automator (located in the Applications
folder) and click Custom followed by Choose to
create a new workflow. Add preexisting actions
if necessary, then click Record to create a Watch
Me Do action (see figure 1.18).

-« ’ . ardi
a Automator: Recording -

Open
Move to Trash

Get Info

Compress “backups”
Duplicate

Make Alias

Copy "backups”
Clean Up Selection

Label:
dAEEs

x -
ﬂ “Red"
More >
T

1.18 Whatever | do while Automator is recording
is added to the Watch Me Do action.
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[ ] Before you can record in Automator, you need to turn on Enab

devices in the Universal Access section of System Preferences (located in the Apple

Note menu).

Perform the steps that you want to record. Don't rush — you want to make sure that you don't do
anything extraneous and that Automator has a chance to catch everything you do. When you're
done, click Stop. Now you can drag the slider to adjust the playback speed.In most cases, you'll want
this action to go as quickly as possible, so you'll drag the slider all the way to the right. Complete your
workflow by adding any other steps that are needed, and then save it.

Finding Lost Files

Organization is a good thing, but it's not nearly as necessary as it used to be with Mac OS X's pow-
erful ability to find just about anything with just one or two search terms. Spotlight, the name for
the search technology that your iMac uses, relies on a comprehensive index of everything (and | do
mean everything) on your iMac, from e-mail to the Web pages you visit to the songs you download
in iTunes. You can search your computer in more than one way, but the search is always based on
Spotlight technology.

Doing a simple Spotlight search

The quickest way to invoke Spotlight and get it looking for your information is to press 38+space-
bar to open the Spotlight menu at the right end of the menu bar. Then type your search terms.
Before you're even done typing, Spotlight starts throwing up results right there in the menu.If you
find what you want, your search is over; just choose the item from the menu to open it. Or choose
Show All, at the top of the menu, to display the search results in a Spotlight window (which is really
just a Finder window) where you can sort them or modify your search further (see figure 1.19). If
you know you'll need to narrow your search after it's begun, you can skip the Spotlight menu and
start out in a Spotlight window by pressing 88+Option+spacebar.

As | mentioned, this method of searching combs through every scrap of information on your iMac
looking for the specified search terms. Sometimes, though, that’s overkill. If you're pretty sure that
the information you're seeking resides in a standard document, such as a text file or a spreadsheet,
you can use the search field in the Finder’s toolbar instead; this restricts the search to individual
documents and leaves out larger databases such as your Address Book and iCal information. To
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search this way, start in single-window mode so you can see the search field,and then click in it and

type your search terms; or press 8-+F any time you're in the Finder to jump straight to the search
field. The Finder will create a new window for you if one isn't already available; your search results

will be displayed in that window.

Search for: Igrwlmund I

Search: “kb” | Contents Save | (+)
Name | Kind

greyhounds - Google Book Search Safari bookmark

Greyhound Race and Breeding Safari history item

The Greyhound Breeding and Racing Database Safari history item

The Greyhound Breeding and Racing Database Safari history item

GPS : Welcome to the Grey...t have adopted Greyhounds  Safari history item

GPS : Welcome to the Grey...t have adopted Greyhounds  Safari history item

male greyhound incontinent - Google Search Safari history item

@ Granite State Greyhounds Transmit Favorite

[~ Kiki3bianca@aol.com Grani...reyhounds at Goddard Park  Mail Message

(=) Tracy [GraniteStateGreyhou...LASS LGRA - Fri Nov 23-07  Mail Message

B Feast Day of St. Guinefort the Greyhound iCal file

B Feast Day of St. Guinefort the Greyhound iCal file

B Feast Day of St. Guinefort the Greyhound iCal file

|| GREYHOUND-L@APPLE.EASE.LSOFT.COM Address Book Person [

[ Misc. greyhounds Folder

[ Misc. greyhounds Folder

[ Granite State Greyhounds Folder

[~ noreply@mac.com Your ph...unds LGRA... is on the web!  Mail Message

Bl Cranite State Greyhounds 5.jpg JPEG image -

I Granite State Greyhounds 6.jpg JPEG image IS
i i i v

e SR

1.19 From the Spotlight window, | can add as many criteria as | need to narrow
my search more.

A

you press 38+F and you'll find that the although the Contents button in the search

window is still selected, Spotlight has cleverly added a Name contains criterion to the

search, and that’s where your cursor has landed.

Using more-complex search criteria

It's certainly possible to conduct a Spotlight search based solely on a few words of text, but if that
results in hundreds or even thousands of hits, you're going to want to narrow your results a bit
rather than sort through the entire list. You can do that by adding additional criteria in the
Spotlight window.
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Click the plus sign at the right-hand end of the window’s Search bar to add a search criterion.In the
new row of menus, choose what you want to base the criterion on from the first menu, and then fill
in your restrictions. For example, if you choose Created date from the first menu, you'll then need to
choose an option such as within last or yesterday from the second menu, and you might need to
type even more information based on that second choice.

included in the search results. Instead of clicking + to add search criteria,

PNl Option+click the button, which changes from a plus sign to an ellipsis. Choose Any,

All, or None from the pop-up menu, then set your criteria and run your search.

You can set up as many criteria as you want and adjust them as you see what files are contained in
your search results.They can use the basic parameters in the first criteria menu (Kind, Last modified
date, Created date, Name, or Contents) or more exotic file attributes found via the Other menu

choice (see figure 1.20).

Select a search attribute: fq—\
F Description [ in Menu
FONT FUIl fame ] >4
General MIDI sequence Whether the MIDI sequence contained in the file is setup... a
Genre Genre =]
Group Group ID of owner of the file =]
Headline Publishabl y of the of the item =]
IS0 speed 150 speed of the camera when the picture was taken (] )
Identifier Reference to a resource within a given context =]
Instant me Instant r addre: ed with this item | |
Instructions Other information concerning the item, such as handlin... =]
Instrument category  Instrument category to which the file belongs =]
Instrument name Type of instrument the file recorded in the file =]
Invalid Font Invalid Font (=] -
Key signature Musical key of the song in the audio file =] i
Venasnede Veoasnrde aecacintad with thic itam m 1T
o)

1.20 Some of the criteria on which you can build a search are just mind-boggling.

Saving a search for future use

If you've used Spotlight to conduct a search that you're likely to do again in the future (say, all files
modified in the last week that contain the word “greyhound”), you can save that search as a smart
folder. Follow these steps:

1. Press 8+spacebar and type your search terms in the Spotlight search field.

2. Inthe Spotlight menu, choose Show All.
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3. Click the plus button to add search criteria that will narrow your results, if needed.
4. Click Save.

5. Type aname and choose a location for the smart folder. Now, any time you open that
folder, it will contain the updated results of the search you just performed. And, if you leave
the save location set to the default (the Saved Searches folder), your saved searches will
appear in the sidebar under Search For.

The special criteria on which you can base a search using the Spotlight window are also
available to you in the Spotlight menu — if you're willing to memorize the keywords that
apply to each criterion.

You can add a filetype parameter to a search in the Spotlight menu; just type kind:pdf,
for example. (Don't put a space after the colon when you're typing these keywords.) The
types you can specify include anything that appears in the Kind column when you're
looking at a Finder window in List view: Alias, Application, Folders, JPEG Images, MP3
Audio Files, and ZIP Archive, for starters. You can also search for a file modified on a
particular date; try searching for date:yesterday or “date:8/1/08, for example. Adding
math operators makes this feature even more powerful; you can insert > (greater than) or
< (less than) to find files dated after or before the date, or specify a date range using a
hyphen (-).

There are about a hundred more keywords that you can access via the Other option
in the Spotlight window’s first search criteria menu. If you're a fast typist, though, you
may prefer to use text keywords in the Spotlight menu for all of these, too. To find out
how to type them, open this file: /System/Library/Frameworks/CoreServices.framework/
Frameworks/Metadata.framework/Resources/English.lproj/schema.string. The term in

the first column, minus the introductory kMDltem, is the keyword to use. To learn more

about how to use these text keywords in Spotlight searches, check out the article on Mac
writer Kirk McElhearn’s excellent Web site (mcelhearn.com; search for “Spotlight’s Secret
Search Syntax”).
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